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Section 1
Getting Started
By the end of this section you should be able to:
Understand Basic E-mail Principles
Start and Close Outlook
Recognise and Use the Outlook Screen
Find Help

Work through the Driving Lessons in this section to gain an understanding of
the above features.
For each Driving Lesson, read all of the Park and Read instructions and then,
if applicable, perform the numbered steps of the Manoeuvres. Complete the
Revision exercise(s) at the end of the section to test your knowledge.
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Driving Lesson 1 - E-mail and Outlook
Park and Read
One of the most popular uses of the Internet is sending and receiving
“electronic mail” (e-mail). E-mail is an extremely important communication tool
that allows people to send multimedia messages to other ICT users anywhere
in the world instantly. Think about how much more quickly information can be
sent using e-mail rather than by traditional surface or airmail.
This guide will introduce you to Microsoft Outlook, a popular Personal
Information Management (PIM) tool that allows you to send, receive and
organise e-mail messages. Outlook can also be used to attach files to
messages, maintain an address book of contacts, and create useful calendars
and to-do lists.
There are many online services that you can use to send and receive e-mail.
However, in most professional situations, an e-mail program such as Outlook is
used.
Before you can use Outlook (or any other e-mail system), you will first need
your own e-mail address. In the same way that a phone number uniquely
identifies an individual telephone on a network, your e-mail address uniquely
identifies your “mailbox” on the Internet (i.e. the location where your e-mail is
delivered).
E-mail addresses all follow the same general format, as the following example
shows:
trainer@bigplanetsupport.co.uk
The @ symbol is pronounced “at” and is used to separate a person’s mailbox
name (which can include full stops, e.g. john.smith) from the name of their
organisation or Internet Service Provider (ISP). Notice that this matches the
organisation’s or ISP’s domain name.
If you do not know your own e-mail address, contact the person who runs your
computer network. If you are a home user, contact your ISP.
Of note, when you are not using Outlook, messages are stored for you until
they are collected. You do not need to keep the program running all of the time.

Manoeuvres
Food for thought:
1.

In 2010 research showed that around 2.8 million e-mails were sent every
second of every day!

2.

There are approximately 1.4 billion e-mail users in the world.
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Driving Lesson 2 - Starting Outlook
Park and Read
Microsoft Outlook is part of the Microsoft Office suite of applications. Although
there are numerous ways to start the program, the following method is
recommended for beginners.

Manoeuvres
1.

Click once on the Start button,
(found at the bottom left of the
screen on the Taskbar), to show the list of start options available. Nearly
all Windows applications can be started from here.

2.

Click once on All Programs. After a moment, a full list of programs will be
displayed.

3.

Click the Microsoft Office folder to display its contents.

4.

To start Outlook, click Microsoft Outlook 2010.

It may also be possible to start Outlook by single clicking the Microsoft
Outlook 2010 entry on Start Menu’s quick launch list (i.e. the list that appears
when you first click the Start button). Alternatively, an icon for the program may
be “pinned” to your Taskbar.
5.

The Outlook window will be displayed. Maximise it (so it fills the screen)
and leave it open for the next lesson.

Outlook may need to be set up before it can be used for the first time. If the
Internet Connection Wizard or Add New Account dialog box appears when
you start Outlook, your computer is not yet ready to use e-mail. It is
recommended that you find somebody who can help you set up an account.
When you start Outlook you may first be asked to connect to the Internet – you
need to do this to send and receive e-mail. If there is more than one e-mail
account (or profile) available on the computer, you will also need to select one.
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Driving Lesson 3 - The Outlook Window
Park and Read
When the Outlook window (or “screen”) appears, the program usually displays
your Mail view by default. All of your e-mail messages are contained here in
folders known collectively as your mailbox.

Manoeuvres
1.

Examine the Outlook window. In particular, locate the Ribbon,
Navigation Pane, Folders List, View Buttons, Message List and
Reading Pane.

Tabs

Ribbon

Message
List
Folders
List

Reading
Pane
Navigation
Pane
To-Do
Bar

View
Buttons

Status
Bar

Outlook features a wide variety of screen layouts and set-up options. As a
result, your screen may not appear exactly as shown above. However, you will
learn how to adjust basic display settings in the next lesson.
Depending upon your e-mail account, you may see more than one mailbox in
the Folders List. If this is the case, you have more than one e-mail account set
up in Outlook, each with its own collection of folders (i.e. Inbox, Drafts, Sent
Items, etc). For this guide, use the mailbox with Personal Folders or your
name/e-mail address as its title.
2.

Locate the Title Bar at the top of the screen. This shows the name of the
mailbox that is currently open.
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Driving Lesson 3 - Continued
3.

At the top left of the screen is the Quick Access Toolbar,
.
Identify the two useful buttons that are available here: Send/Receive All
Folders and Undo.

As you will learn later, more buttons can be added to this toolbar.
4.

Locate the Ribbon. This consists of a range of tabs containing buttons
within groups.
File tab

The File tab contains a list of basic program functions such as Open, Save As,
Print and Exit. More advanced options can also be found here.
5.

The buttons on the Ribbon are used to select an action or command in
Outlook. Move the mouse pointer over any button but do not click. Read
the ToolTip that appears which gives the name of that button and a small
description.

6.

Find the To-Do Bar which appears on the right side of the screen. This
features upcoming tasks and diary appointments.

7.

Find the Status Bar which runs along the bottom of the window. This
displays messages as tasks are performed. It will currently show the total
number of messages (or items) in your Inbox.

8.

Notice the Zoom slider on the right side of the Status Bar. This can be
used to increase or decrease zoom levels in the Reading Pane.

9.

Leave the Outlook window open for the next lesson
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Driving Lesson 4 - Outlook Views
Park and Read
There are many different views available in Outlook, but perhaps the most
important is your Mail view. This shows a Folders List containing all of the
various mailbox folders available to you (e.g. Inbox, Sent Items, Deleted
Items, etc). To open a folder and view its contents, simply click the folder title
on the Navigation Pane.

Manoeuvres
1.

Notice that Mail is the currently selected view button on the Navigation
Pane (as shown in lesson 3). If it is not, select it now.

2.

Find and examine the contents of the Folders List. If your Inbox folder is
not currently selected, select it now.

All messages that you receive are placed in your Inbox folder.
3.

Locate the Message List. This will show all of the messages currently
contained in the selected folder. If this is the first time you have used
Outlook, your Inbox folder will probably be empty.

4.

Locate the Reading Pane. The content of any message selected in the
Message List is previewed in the Reading Pane.

Outlook features a range of useful options to hide, show, reposition and resize
the Navigation Pane, Reading Pane and To-Do Bar.
5.

Display the View tab. Then, in the Layout group, click the Navigation
Pane drop down button. From the options that appear, select Minimized
and observe the effect.

6.

Next, click the Reading Pane button in the Layout group. Select the Off
option and observe the effect.

7.

The To-Do Bar shows upcoming appointments and tasks. To hide the
To-Do Bar, click the To-Do Bar button and select Off.

8.

To minimise the Ribbon, click the Minimize the Ribbon button,
,
shown at the top right of the Outlook window (or press <Ctrl F1>). Hiding
the Ribbon gives you a little more room to work in.
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Driving Lesson 4 - Continued
Expand/Minimize
Ribbon

9.

To restore the Ribbon, click the Expand the Ribbon button,

.

10. Click the Calendar view button on the Navigation Pane. The Outlook
Calendar is shown. As you will learn later, this can be used to plan your
daily activities and to schedule appointments and meetings.
If your organisation supports it, you can choose to share your Calendar with
others on your network. This makes it very easy for others to see what you are
doing and to organise meetings with your colleagues.
11. Click the Tasks view button on the Navigation Pane. This view can be
used to create useful task lists and reminders.
12. Click the Mail view button to return to your mailbox.
In practice you can choose whichever screen layout you feel is most practical.
However, for the remainder of this guide, it is recommended that you set up
Outlook using the following instructions.
13. To adjust your screen’s Mail layout to match this guide’s recommended
settings, display the View tab and click the Change View drop-down
button in the Current View group. Select Compact.
14. Then, using the buttons in the Layout group, make sure Navigation Pane
is set to Normal, Reading Pane is set to Bottom, and To-Do Bar is set
to Minimized, as shown below.

The various panes can be resized or hidden by dragging their boundary bars.
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Section 2
Send & Receive
By the end of this section you should be able to:
Compose a New E-mail Message
Address an E-mail
Send an E-mail
Receive an E-mail
Mark an E-mail as Read/Unread

Work through the Driving Lessons in this section to gain an understanding of
the above features.
For each Driving Lesson, read all of the Park and Read instructions and then,
if applicable, perform the numbered steps of the Manoeuvres. Complete the
Revision exercise(s) at the end of the section to test your knowledge.
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Driving Lesson 8 - Creating a Message
Park and Read
New e-mail messages can easily be created in Outlook. All you need is the
e-mail address of the recipient (i.e. the person you are sending the message
to).
Always be careful when you enter an e-mail address. One letter out of place will
result in the message being returned “undelivered” or – even worse – going to
the wrong person.

Manoeuvres
1.

Start Outlook. When the Outlook window opens, the Mail view should
appear automatically with the Inbox folder selected.

2.

Locate the New group on the Ribbon (make sure the Home tab
is displayed). Click the New E-Mail button to start a new
message.

3.

An Untitled Message window appears.

To box
Subject box

Message
Area

To give you more space to work in, you should maximise the Untitled
Message window (i.e. make it fill your entire screen) by clicking the Maximize
button,
, on the window’s Title Bar.
4.

Notice that the cursor is currently flashing in the To box (if it is not, click
inside the To box now). The To box is where you enter the e-mail address
of the person you are sending the message to.

5.

For this lesson, type your own e-mail address into the To box.
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Driving Lesson 8 - Continued
Entering your own e-mail address in the To box will cause any message you
send to be immediately returned to you. This allows you to observe the results
of sending messages. Sending a message to another person follows exactly
the same steps.
6.

Click once in the Subject box. The text you enter here is used to briefly
describe the content of your e-mail (allowing the recipient to see at a
glance what the message is all about).

It is good practice to always enter a short but relevant subject for every new
message that you create.
7.

Enter the following subject text: My First ECDL Message.

The e-mail address trainer@bigplanetsupport.co.uk will be used in
screenshots throughout this guide. Wherever relevant, you will be prompted to
substitute this with your own e-mail address.
8.

Click once in the Message Area. Notice that the title of the e-mail, shown
on the Title Bar, now changes to My First ECDL Message.

9.

Type the following text into the Message Area:
I am sending this e-mail message as part of my studies for ECDL.

If you make a spelling mistake when typing it will be underlined in red. You will
learn more about correcting spelling errors in the next section.

10. Leave the new e-mail message open for the next lesson.
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Driving Lesson 9 - Sending a Message
Park and Read
When you have finished composing a new e-mail, the message is ready to be
sent. Copies of sent messages are stored in the Sent Items folder for you to
refer back to later.

Manoeuvres
1.

The e-mail created in the previous lesson (My First ECDL Message)
should still be open. You are now going to send it.

It is always a good idea to check the content of e-mail messages before you
send them to ensure address, subject and message texts are all correct. Once
an e-mail is sent, there is very little you can do to get it back again.
2.

Click the Send button to send the message to the recipient (yourself in
this case).
Send Button

If you receive a prompt to correct spelling errors in your message, click Cancel.
Checking e-mail for spelling errors is covered in a later lesson.
3.

The e-mail window automatically closes and the message is sent to your
Outbox.

E-mail messages that you send are first moved to your Outbox folder before
being sent. If you are connected to the Internet, they will be sent immediately
from there. If you are not, messages will remain in your Outbox until you
connect – this way you can create e-mail messages “offline” and then send
them when you connect.
4.

Select the Outbox folder,
, from the Folders List. Any
messages waiting to be sent are shown here.

If your Outbox is empty (and no number is shown in square brackets after the
folder name on the Folders List), then your message has already been sent.
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Driving Lesson 9 - Continued
The Send/Receive All Folders button can be used to force Outlook to send
any waiting messages (if this does not occur automatically).
As it is used frequently, a Send/Receive All Folders button is also available on
the Quick Access Toolbar, . You can also use the keyboard shortcut <F9>,
5.

Display the Send/Receive tab.

6.

Then, click the Send/Receive All Folders button. A
progress dialog box, as shown below, may appear for a
moment. If you are prompted to connect to the Internet,
please do so.

A Send/Receive status message may be shown on the Status Bar. Always
wait for the Send/Receive process to finish before moving on.

7.

Select the Sent Items folder,
a copy of your message is saved here.

8.

Leave Outlook open for next lesson.
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Driving Lesson 10 - Receiving a Message
Park and Read
When you receive an e-mail it is stored in your Inbox folder. New and unread
messages are shown in the Message List in bold type with an unopened
envelope icon, . Once you read the message its icon changes to an open
envelope,
.
E-mail messages are stored on a mail server (either in your company or at your
ISP) which is where they remain until you download them. You do not need to
keep the program running all of the time.

Manoeuvres
1.

Select your Inbox folder,
, from the Folders List. The folder’s
contents are shown in the Message List.

Notice the number shown in brackets after the folder name; if applicable, this
shows the number of unread messages in that folder.
2.

After a short time you will receive the message that you sent to your own
address in the previous lesson. If it has not appeared in your Inbox yet,
use the Send/Receive All Folders button to check for new messages.

Outlook will regularly check for new messages automatically, but clicking the
Send/Receive All Folders button forces it to check for new messages
immediately. Bear in mind that it sometimes takes a little while for messages to
“pass through the system”.
3.

Notice the closed envelope icon and bold text indicating that the new
message has not yet been read. The name shown indicates who the
e-mail was sent from, followed by the message’s subject text and the date
and time it was received.

It is possible that Outlook will identify this message as Junk Mail and store it in
a special Junk E-mail folder (which you will learn more about later). If so, open
the Junk E-mail folder on the Navigation Pane and select the My First ECDL
Message e-mail. Display the Home tab on the Ribbon and click the Junk
button,
, in the Delete group. From the submenu that appears, select
Not Junk. The message will be moved back to the Inbox.
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Driving Lesson 10 - Continued
4.

Click the message once on the Message List, if it is not already selected,
to preview its contents in the Reading Pane.

5.

Double click the e-mail on the Message List to open it in a new window.
Notice the features available on the Ribbon.

6.

Close the e-mail by clicking the Close button,
right corner of the message window.

7.

Notice the My First ECDL Message e-mail on the Message List. The
closed envelope icon will have changed to an open envelope and the bold
formatting will be removed. This indicates that the message has now been
read.

, found towards the top

Sometimes you will open an e-mail but not have time to read it. Being able to
mark items as Unread so that you can return to read them later is a very useful
feature.
8.

To mark the My First ECDL Message e-mail as Unread, first make sure
the Home tab is displayed.

9.

Then, click the Unread/Read button,
, in the Tags group.
The message’s open envelope icon changes back to a closed envelope
and the text reverts back to bold.

Similarly, you can use the Unread/Read button to mark an unread message as
read.
10. Click the Unread/Read button again to mark the message as read.
11. Leave your Inbox open for the next lesson.
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Driving Lesson 11 - Revision
Park and Read
At the end of every section you get the chance to complete one or more
revision exercises to develop your skills and prepare you for your ECDL
certification test. You should aim to complete the following steps without
referring back to the previous lessons.

Manoeuvres
1.

Create a new e-mail message with the subject: Developing My Skills.

2.

Enter your own e-mail address in the To box.

3.

In the Message Area type:
Always remember to check my e-mail regularly!

4.

Send the message.

5.

Check your Outbox to make sure that the new e-mail has been sent (use
the Send/Receive All Folders button if necessary on the Send/Receive
tab).

6.

View your Sent Items folder to check that a copy of the message has
been saved.

7.

Return to your Inbox and wait for the Developing My Skills e-mail to
appear (use the Send/Receive All Folders button to check for new
messages if needed).

8.

Preview the message in the Reading Pane.

9.

Double-click the message to open it in a new window.

10. Close the Developing My Skills message window.
11. Mark the message as Unread.
12. Mark the message as Read again.
Now complete the Record of Achievement Matrix at the back of the guide.
You should only move on when confident with the topics and features
described in this section.
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Section 8
Contacts
By the end of this section you should be able to:
Add and Remove Contacts
Maintain and Edit Contacts
Create a Contact Group
Send Messages to Contacts
Delete Contacts

Work through the Driving Lessons in this section to gain an understanding of
the above features.
For each Driving Lesson, read all of the Park and Read instructions and then,
if applicable, perform the numbered steps of the Manoeuvres. Complete the
Revision exercise(s) at the end of the section to test your knowledge.
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Driving Lesson 35 - Creating Contacts
Park and Read
Over time you will find that many of the e-mail messages that you create will be
sent to the same group of people. Often these will be friends, family or work
colleagues. To avoid having to remember all of their individual e-mail
addresses and personal details, you can store them in Outlook’s Contacts
(also known as the Address Book).

Manoeuvres
1.

From the Outlook Navigation Pane, click the Contacts view button.

2.

The Contacts view appears. If you have never used this view
before the list will probably be empty.

3.

To create a new contact, click the New Contact button in the
New group on the Home tab.

4.

An Untitled Contact window appears. Enter your own personal details
into the text boxes (you do not need to complete every box). Make sure
you enter your real e-mail address correctly, however, as this will be used
in later lessons.

If any dialog boxes appear (e.g. prompts to check full name or conversion of
telephone numbers), click Cancel to continue.
5.

After all of the information has been entered, click the Save &
Close button in the Actions group. A personalised contact has
now been created for you.
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Driving Lesson 35 - Continued
6.

The new contact will appear as a “virtual” Business Card (make sure
Business Cards is selected on the Ribbon in the Current View group).

7.

Let’s try adding a few more contacts. Click the New Contact button again
and enter the following details:
Full Name:
Company:
Job Title:
E-mail:
Business Phone:

Fiona Jones
Big Planet Support
Reception Assistant
fiona@bigplanetsupport.co.uk
0770 0900 823

Always make sure you enter details accurately, especially e-mail addresses
and phone numbers. Personal details such as date of birth, nickname or
anniversary can also be included by selecting Details in the Show group.
8.

Save & Close the new contact. The contact’s business card is created.

9.

Add the following friend as a new contact:
Full Name:
Company:
Job Title:
E-mail:
Business Phone:

Hassan Khan
Big Planet Support
Custom Contact Officer
hassan@bigplanetsupport.co.uk
0770 0900 472

10. Leave the Contacts view open for the next lesson.
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Driving Lesson 36 - Editing Contacts
Park and Read
Outlook makes it easy to change contact details by simply double clicking an
entry in the Contacts view. The record can then be edited as required before
selecting Save & Close to update the information.

Manoeuvres
1.

The Contacts view should still be open from the previous lesson. Locate
the Business Card for Fiona Jones.

2.

You have been informed that she has been promoted to Reception
Manager and her work telephone number has changed to 0770 0900 583.
Let’s edit her contact record…

3.

Double click her Business Card. The Contact window appears.

4.

Change Fiona’s Job Title to Reception Manager and her Business
phone number to 0770 0900 583.

5.

Click Save & Close to save the new information. Notice that her
Business Card is automatically updated.

6.

Hassan Khan has transferred to another department. His new Job Title is
IT Support Executive and his Business phone number is 0770 0900
643. Change his contact record accordingly.

7.

Hassan has a new mobile phone. His number is 0770 0900 432. Add this
information to his contact record.

8.

Leave the Contacts view open for the next lesson.
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Driving Lesson 37 - Using Contacts
Park and Read
The Outlook Address Book provides another view of your Contacts. When
you create a new e-mail message (or forward a message to another recipient),
it can be used to quickly look up and select e-mail addresses stored in your
Contacts list.

Manoeuvres
1.

Return to the Mail view by clicking the Mail view button on the Outlook
Navigation Pane.

2.

Create a new e-mail message by clicking the New E-mail button on the
Ribbon. An Untitled Message window appears.
To button
Cc button

Bcc button

3.

Notice the To, Cc and Bcc buttons. These allow you to open your
Address Book and select the e-mail addresses of people in your
Contacts list.

4.

Click the To button,

5.

From the drop-down box found below Address Book, make sure
Contacts is selected (if it is not already).

. Your Address Book opens.

It is possible to have more than one list of contacts. For example, if your
computer is connected to a network (perhaps at work), a Global Address List
may also be available listing the details and e-mail addresses of all users on
the network.
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6.

Select the entry for Fiona Jones, and then click the To button,
Her e-mail address is copied to the To box.

7.

Click OK. Her e-mail address now also appears in the e-mail’s To box.

.

Notice the format of the contact’s name and e-mail address in the To field. This
is determined by the contents of the Display as box when creating a new
contact.
8.

Click the Cc button,

. The Address Book appears again.

Once again, make sure Contacts is selected in the Address Book drop-down.
You will need to do this every time you use your Address Book.
9.

Select your own contact record and click the Cc button,
e-mail address is copied to the Cc box. Click OK.

10. Click the Bcc button,
the Bcc field. Click OK.

. Your

, and add Hassan Khan’s e-mail address to

11. Enter the e-mail message subject as Your Promotion.

12. Finally, enter the following message in the Message Area:
Hi Fiona. I hear you have been promoted. Congratulations!
13. Send the message (a Carbon copy will be returned to you).
When you receive a message from another person, you can add their details to
your Contacts by right-clicking their name or e-mail address in the Reading
Pane’s header area and selecting Add to Outlook Contacts.
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